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Executive Summary 
This document provides the information required by a user to apply the spreadsheet tool 
ZOOM_IGARF to run the groundwater flow model ZOOMQ3D and other associated utilities 
for the investigation of the impact of groundwater abstraction on river flows.  This tool has 
been developed to improve the techniques available to Environment Agency hydrogeologists 
involved in involved in assessing the impact of groundwater abstraction on river flows. 

The existing tools developed by the Agency as part of the Impacts of Groundwater 
Abstraction on River Flows (IGARF) project (NC/00/28) are adequate for up to about 50% of 
abstraction licence assessments.  However, it is recognised by the developers that the existing 
IGARF analytical models do not produce results with sufficient confidence where: 

• The particular hydrogeological setting significantly influences the impact of an 
abstraction and generic tools such as IGARF 1 are inadequate. 

• The groundwater level falls below the bed of the river and away from hydraulic 
contact with the river. 

• A more accurate spatial or seasonal distribution of the impacts on both flow and 
groundwater level is important, for example when the effects of several abstractions 
must be considered. 

• There is a variation of hydraulic conductivity with depth as in most Chalk and 
limestone catchments. 

• The regional context is important for estimating the local impact, which is often true 
for wetland sites. 

Such features are represented in the many regional groundwater models that the EA has 
developed, however, these cannot be run quickly, i.e. within the time constraints of a 
licensing officer.  The cost of developing a regional groundwater model, where one does not 
currently exist, is approximately £200k to £300k.  Consequently, a tool is required to assess 
the impact of groundwater abstraction on river flow, which is relatively easy and quick to use 
but which incorporates some of the complex features that can be simulated by regional 
groundwater models.  The Excel spreadsheet, ZOOM_IGARF has been developed for this 
purpose.  This simple spreadsheet tool is used as pre and post-processor for the groundwater 
flow model ZOOMQ3D with which a user can construct models including, for example, 
multiple dendritic river catchments.  It is then possible to run the model and process the 
output to analyse the impact of an abstraction borehole on one or more reaches of a river 
within a catchment.  The benefit of the use of Excel is that its application requires little prior 
knowledge of the structure of the input and output of the flow model, ZOOMQ3D. 
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1 Introduction  
The Excel workbook “ZOOM_IGARF.xls” has been developed to enable the rapid 
assessment of the impact of an abstraction borehole on river baseflow using the numerical 
groundwater flow model, ZOOMQ3D.  The spreadsheet provides clear and simple methods 
to (i) construct the input files required by the flow model (ii) run the flow model and 
(iii) analyse its output.  Whilst the flow model can provide information on the variation of 
groundwater head and river baseflow over-time, the spreadsheet modelling process has been 
designed to quantify and plot the amount of water that an abstraction borehole draws from a 
river reach or multiple reaches.  The rate at which the abstraction borehole reduces the flow 
in a reach of a river after it starts to pump is termed the depletion rate.  An example of the 
output of the spreadsheet modelling process is shown in Figure 1 in which the depletion rate 
is calculated for two river reaches for a single abstraction borehole. 

 

 
Figure 1 Example depletion rate curves plotted using the Excel spreadsheet 
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The aim of the Excel workbook is to prepare the input files of the numerical groundwater 
model ZOOMQ3D and analyse the impact of abstraction on river baseflow by running the 
flow model.  The number of input files required to define the structure of the numerical 
model varies with its complexity.  This depends on the conceptual model used to represent 
the aquifer system.  This spreadsheet tool produces the basic files required by ZOOMQ3D to 
simulate the impact of abstraction on a groundwater system.  For example, ZOOMQ3D is 
capable of simulating groundwater flow in three dimensions in heterogeneous aquifers, but 
the Excel workbook only allows the consideration of homogeneous aquifers using one layer 
of finite-difference nodes.  This level of complexity has been deemed adequate for the 
assessment of the impact of the abstraction using this tool given the likely restricted amount 
of time available during a licence assessment.  Additional complexity can be introduced into 
the model by manually editing the model text input files produced by the spreadsheet tool.  
However, this requires a more detailed knowledge of the ZOOMQ3D input files structure. 

Each worksheet of the Excel workbook deals with one specific type of model data.  The input 
data varies from that which is spatially varying such as the physical structure of the model to 
temporally varying information such as pumping rate. The worksheets of the Excel workbook 
are organised so that if they are followed from left to right, the process of constructing and 
running the model is undertaken. 
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2 Installing the workbook 
The workbook “ZOOM_IGARF.xls” can be copied into any user defined directory.  The 
Microsoft Excel program must be available on the user’s machine and should allow the use of 
macros.  The user has to ensure that the “Analysis ToolPak” and the 
“Analysis ToolPak VBA” are selected within Excel from the <Tools> <Add-Ins> menu.  
Some of the worksheets in the Excel file launch external executable files.  These are: 

• ZOOMQ3D.EXE 

• ZETUP.EXE 

• CREATE_RIVER_SPLINES.EXE 

• MODIFY_MODEL_RIVERS.EXE 

These executables should be copied into a folder called “ZOOM_IGARF” under the root 
directory of a drive chosen by the user, for example drive “c”. 
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3 Using the spreadsheet tool 
3.1 LAYOUT OF THE EXCEL WORKBOOK 
The Excel workbook “ZOOM_IGARF.xls” is composed of seventeen worksheets which are 
arranged in the following order from left to right: 

1. Help 10. Monitoring Points 
2. Project Details 11. Abstraction 
3. Create Base Grid 12. Initial River Flows 
4. Boundary Definition 13. Time Variant River Flows 
5. Rivers 14. Run ZOOM 
6. Clock & SOR 15. Depletion Rates 
7. Regional Parameters 16. No Pumping Results 
8. Fixed Heads & Leakage 17. Pumping Results 
9. Boundary Condition   

Each of the worksheets is clearly laid out.  By progressing through the worksheets in this 
order and entering data where required, the user constructs and runs the flow model, 
ZOOMQ3D.  The spreadsheet then calculates and plots the rate of depletion of river baseflow 
due to groundwater abstraction for the selected river reaches. 

3.2 HELP WORKSHEET 
The first worksheet of this tool “Help” instructs the user of how to install and use the 
spreadsheet tool (Figure 2).  It summarises the procedure for determining the impact of an 
abstraction borehole on a reach, or multiple reaches of a river. 

3.3 PROJECT DETAILS WORKSHEET 
This sheet allows the user to write descriptive information such as the purpose of the model 
run, the name of the modeller and the date the work was undertaken.  The user can record any 
other information that is deemed relevant here. 



OR/08/009 

5 

 
Figure 2 The “Help” worksheet 

3.4 CREATE BASE GRID WORKSHEET 
This worksheet is used to specify the working directory, and to define the size and structure 
of the mesh (Figure 3). 

• To set the working directories: 

o Cell F3: Enter the working directory of the project.  This must be the path of the 
directory where the Excel workbook is located. 

o Cell I3: Enter the letter of the drive under which the directory “ZOOM_IGARF” 
is located.  Refer to Section 2. 

ZOOMQ3D allows the use of one coarse grid and as many sub-grids (refined grids) as 
required (Figure 4).  The mesh is regular but the cells composing it do not have to be square 
i.e. a different mesh spacing can be used in the x and y directions.  This worksheet maintains 
this functionality.  The required information entered as follows: 



OR/08/009 

6 

• Base grid information; 

o Cell B6: Enter the x co-ordinate of the lower left corner of the base grid (m). 

o Cell C6: Enter the y co-ordinate of the lower left corner of the base grid (m). 

o Cell B8: Enter the x co-ordinate of the upper right corner of the base grid (m). 

o Cell C8: Enter the y co-ordinate of the upper right corner of the base grid (m). 

o Cell D8: Enter the cell size.  This worksheet allows the creation of square meshes 
only so the value entered here represents the dimensions of the cells in the x and y 
directions.  The values of Cells B10 and C10 are updated automatically. 

• Sub-grid information: 

Proceed by pressing the buttons to add or remove sub-grids.  The numbers of sub-grids is 
shown in Cell B18 and the cells required to set the sub-grids characteristics are 
automatically highlighted from Cell B20 onwards.  For each sub-grid, enter the following 
data:  

o Cell B(19+i): Enter the x co-ordinate of the lower left corner of the ith sub-grid 
(m). 

o Cell C(19+i): Enter the y co-ordinate of the lower left corner of the ith sub-grid 
(m). 

o Cell D(19+i): Enter the x co-ordinate of the upper right corner of the ith sub-grid 
(m). 

o Cell E(19+i): Enter the y co-ordinate of the upper right corner of the ith sub-grid 
(m). 

o Cell F(19+i): Enter the number of divisions, i.e. the number of refined grid 
intervals per coarse grid interval,  in the x direction 

o Cell G(19+i): Enter the number of divisions, i.e. the number of refined grid 
intervals per coarse grid interval, in the y direction 

where ni →= 1  and n is the total number of sub-grids. 
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Figure 3 The “Create Base Grid” worksheet 

 

 

 
Figure 4 Example of a refined model mesh 
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3.5 BOUNDARY DEFINITION WORKSHEET 
This worksheet allows the user to define a simple rectangular boundary or to prepare a text 
file that describes a complex boundary that has been constructed in ArcView.   

• To prepare a simple rectangular boundary, press the “Produce a simple rectangular 
boundary” button (Figure 8).  A rectangular boundary will be generated.  This boundary 
is created based on the values specified in Cells B10 and C10 of the “Create Base Grid” 
worksheet. 

• To define a more complex boundary it is necessary to use ArcView and perform the 
following procedure: 

o Press the “Write DXF file” button in the “Create Base Grid” worksheet. 

o This will create a file called “basegridsquare.dxf”.   

o Create an ArcView project and add the following extensions: “Cad Reader” and 
“Spatial analyst”. 

� Add “basegridsquare.dxf” to the ArcView project as a theme by selecting 
“View->Add Theme” from the menu. 

� If you already have a shape file of your model boundary then use this for 
the next operation, otherwise create a new polygon theme and draw the 
model boundary.  This must be contained within the limit of the dxf file just 
added (Figure 5). 

� Ensure your boundary theme is selected i.e. the active theme. 

� Select “Theme->Convert to grid” from the menu 

� Select a name for your new grid theme and press “OK” 

� Set the “Output Grid Cell Size” (Figure 6) to “As Specified Below” and set 
the value in the edit box next to the “Cell Size” to the same value specified 
in the Excel sheet, Cell D8 of “Create Base Grid Worksheet” (Figure 3). 

� Select “Same as Basegridsquare.dxf” for the output extent (Figure 6).  The 
number of rows and columns in the ArcView active dialog box should be 
updated and should be equal to the values given in Cells B10 and C10 of 
the “Create Base Grid” worksheet (Figure 3).  Press “OK” in answer to the 
subsequent messages.  A new theme will be added to the view (Figure 7). 

� Choose “File->Export data source” from the menu.  Choose ASCII raster.  
Select the newly created grid theme and then a name for the output asc file. 

o Open the exported ASCII data in a new Excel workbook.   

o Ignore the first six rows containing the header lines of the ASCII file and copy 
the other cells containing data, starting from Cell A7, and paste them in the 
“Boundary Definition” worksheet starting from Cell A6.    

o Press the “Format boundary” button then the “Produce boundary file” button 
(Figure 8). 
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Figure 5 Example DXF file of model grid imported into ArcView and a polyline theme of the 
aquifer boundary 

 

 
Figure 6 Dialog box used during conversion of polyline boundary theme to a grid 
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Figure 7 The gridded boundary theme after conversion using ArcView 

 

 
Figure 8 The “Boundary Definition” worksheet 
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3.6 RIVERS WORKSHEET 
This worksheet allows the user to construct simple straight-line rivers or to run the 
CREATE_RIVER_SPLINES application to create more complex create rivers.   

• To create simple straight rivers:  

o Use the buttons “Add river” and “Remove river” to add and remove rivers.  The 
number of rivers is adjusted automatically in Cell C18 (Figure 9).   

o Set the characteristics of the rivers in the activated cells from B22 onwards.  
Each row of data starting from Row 22 corresponds to one river.  The data 
included in these cells are: 

� Cell B(21+i): This cell holds an integer representing the river number.  This 
value is written automatically when a river is added. 

� Cell C(21+i): Enter the x co-ordinate of the downstream end of the ith river 
(m). 

� Cell D(21+i): Enter the y co-ordinate of the downstream end of the ith river 
(m).  

� Cell E(21+i): Enter the stage of the downstream end of the ith river (m). 

� Cell F(21+i): Enter the x co-ordinate of the upstream end of the ith river 
(m). 

� Cell G(21+i): Enter the y co-ordinate of the upstream end of the ith river 
(m).  

� Cell H(21+i): Enter the stage of the upstream end of the ith river (m). 

� Cell I(21+i): Enter the bed conductivity of the ith river (m day-1). 

where ni →= 1  and n is the total number of rivers. 

• The CREATE_RIVER_SPLINES interface allows the user to create a complicated 
network of rivers.  Press the button “Run river interface” to launch this application.  For a 
full description of how to use this application refer to Section 4.3.2. 

After defining the rivers, the structure of the numerical model can be built.  The application 
ZETUP, which is a pre-processor for the flow model, is used to construct the model grids and 
rivers.  To run this application, press the button “Run ZETUP”.  Two operations are 
performed: 

1. Before ZETUP is run, a text file is created for each river defined in the model.  These 
text files are given the name “River##_SplinePts.dat” where ## represents the ID 
number of the river.  ZETUP reads these files to create the model rivers i.e. the 
numerical representation of the rivers on the finite difference mesh. 

2. A DOS box is opened and ZETUP is run.  ZETUP reads an ASCII text file produced 
by the Excel spreadsheet and creates the finite difference mesh as illustrated in 
Figure 10.  ZETUP then asks the user if rivers are to be included in the model. 

• Type ‘y’ for yes if rivers are included in the model and ‘n’ for no if not. 

• Write the name of the river data file “River##_SplinePts.dat” where ## should be 
01 for the first river file, 02 for the second river file etc. 

• Repeat the above two steps for all the rivers. 
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Figure 9 The “Rivers” worksheet 
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Figure 10 Example output during execution of ZETUP from “Rivers” worksheet 

3.6.1 River-aquifer interaction 
In ZOOMQ3D river-aquifer interaction is represented as a linear head-dependent leakage 
mechanism.  The rate of leakage depends on the difference between groundwater head and 
river stage and is expressed by: 

( )ra
z

z hhLW
B

KQ −⋅⋅⋅=  

where 
Qz is the leakage rate (m3day-1), 
Kz is the vertical hydraulic conductivity of the river bed (m day-1), 
B is the thickness of the river bed (m), 
W is the width of the river (m), 
L is the length of the river reach (m), 
h a is the head in the aquifer (m) and, 
h r is the river stage (m). 

Therefore, when the groundwater head is above the river stage groundwater discharges to the 
river.  As the groundwater head falls below the river stage, the river starts to lose water to the 
aquifer until a limiting rate is reached.  The above equation is modified when the head in the 
aquifer falls below the base of the river bed, ( )BZBOT − , where BOTZ  is the elevation of the 
bed of the river.  Under these conditions, the driving head is equal to the difference between 
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the river stage and the base of the river bed, ( )BZBOT − .  The leakage from the river under 
perched conditions is therefore defined as: 

( )[ ]rBOT
E
Zz hBZLWKQ −−⋅⋅⋅=  

Figure 11 shows the relationship between groundwater head and river leakage applied in 
ZOOMQ3D. 

The Excel spreadsheet “ZOOM_IGARF.xls” and associated utilities produce a simplified 
river input file for the flow model.  In this file some of the river parameters are set to unity to 
simplify the representation of the river.  In this case, river aquifer interaction is represented 
by the equations shown in Table 1. 
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a) Influent river 

( )ra

I
Z

z hhLW
B

KQ −⋅⋅⋅=  

 

 

 

b) Effluent river.  Groundwater head 
above the base of the river bed, 
( )BZBOT − , but below river stage 

( )ra

E
Z

z hhLW
B

KQ −⋅⋅⋅=  

 

c) Effluent river.  Groundwater head 
below base of the river bed, ( )BZBOT −  

( )[ ]rBOT
E
Zz hBZLWKQ −−⋅⋅⋅=  

 

 

Qz is the flow rate (m3day-1) from 
the aquifer to the river, 

E
ZK  is the vertical hydraulic 

conductivity of the river bed (m day-1) 
under effluent river conditions, 

I
ZK  is the vert ical hydraulic conductivity of the river bed (m day-1) under 

influent river conditions, 

BOTZ  is the elevation of the bed of the river, 

B is the thickness of the river bed (m), 
W is the width of the river (m), 
L is the length of the river reach (m), 
h a is the head in the aquifer (m) and, 
h r is the river stage (m). 

 

ha
rh

B
ZBOT

 

Figure 11 Representation of river aquifer interaction in ZOOMQ3D 
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Table 1 Simplified representation of river-aquifer interaction in ZOOM_IGARF 

Flow equation Assumptions 

( )⋅−⋅⋅= raZz hhLKQ  for 1hh ra −>  River width (W) = 1 m 
Bed thickness (B) = 1 m 

ZK  has the same value for influent and 
effluent conditions. 
( ) ( ) 1hBZhZ rBOTrBOT −=−⇒=  

LKQ Zz ⋅−=  River width (W) = 1 m 
Bed thickness (B) = 1 m 

ZK  has the same value for influent and 
effluent conditions 
( ) ( ) 1hBZhZ rBOTrBOT −=−⇒=  

 

An example relationship between groundwater head and river leakage is shown in Figure 12 
for a given river stage and river bed hydraulic conductivity. 
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Figure 12 Example relationship between groundwater head and river leakage in ZOOM_IGARF 
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3.7 CLOCK & SOR WORKSHEET 
This worksheet is used to specify the number of years to be simulated (Cell D4) and the year 
the simulation starts (Cell D5).  The user can also specify if this run is a continuation from a 
previous simulation (Refer to Appendix A, Section A3.3 for more details).  If this model is 
being re-run set Cell D6 to “t” for true and if it is a new run set Cell D6 to “f” for false 
(Figure 13). 

The Successive Over Relaxation (SOR) method is used to solve the numerical equations.  
This is an iterative technique which converges towards the solution. The iteration procedure 
is stopped when a specified level of accuracy has been achieved.  The parameter that controls 
the convergence of the numerical solution is defined in Cell D11.  A value greater than or 
equal to 1.0 but less than 2.0 must be used.  The maximum number of iterations is specified 
in Cell D12.  This parameter represents the number of iterations after which the model 
progresses to the next time step if the convergence criterion is not satisfied.   ZOOMQ3D 
writes convergence information after a certain number of iterations to a text file (Refer to 
Appendix A, Sections A3.10).  This number is specified in Cell D13. 

 

 
Figure 13 The “Clock & SOR” worksheet 

3.8 REGIONAL PARAMETERS WORKSHEET 
As discussed previously, the Excel workbook only allows the construction of a numerical 
model with one layer.  This layer is homogeneous and recharge can only be distributed 
uniformly across it.  The aquifer parameter values are specified in this worksheet.  These 
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values are assigned to all the finite-difference nodes in the model.  These parameters values 
are defined using the following cells (Figure 14): 

• Cell C3: Set the elevation of the top of the aquifer (m).   

• Cell D3: Set the elevation of the base of the aquifer (m). 

• Cell E3: Set the horizontal hydraulic conductivity of the aquifer (m day-1).  

• Cell F3: Set the specific storage of the aquifer (m-1).  

• Cell G3: Set the specific yield of the aquifer.  

• Cell H3: Set the initial heads at the start of the simulation (m).  To use this value, the 
flag in Cell D6 of the “Clock & SOR” worksheet should be set to ‘f’. 

• Cell I3: Set the recharge rate (mm day-1). 

• Cell J3: A flag to specify if the model is simulating a confined (c) or an unconfined 
(u) aquifer. 

 
Figure 14 The “Regional Parameters” worksheet 

3.9 FIXED HEADS & LEAKAGE WORKSHEET 
This worksheet is used to specify any fixed head nodes inside the model boundary and any 
head dependent leakage nodes within the model (Figure 15).  Fixed heads may be required, 
for example, to represent large surface water features such as a lake and leakage nodes could 
be used to represent spring discharges. 
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• To specify the fixed head nodes:  

o Use the buttons “Add a fixed head node” or “Remove a fixed head node” to add 
or remove fixed head nodes.  The number of the fixed head nodes is adjusted 
automatically in Cell B5.   

o Set the location of the fixed head nodes in the cells located in Columns B, C and 
D.  Set the fixed head values (m) in the cells of Column E, that is: 

� Cell B(6+i): A value of 1 should be entered in this cell.  This is the layer 
number where the node is located.  Since only one layer is allowed, this cell 
should only hold a value of 1. 

� Cell C(6+i): Enter the x co-ordinate of the ith fixed head node (m). 

� Cell D(6+i): Enter the y co-ordinate of the ith fixed head node (m).  

� Cell E(6+i): Enter the value of the fixed head (m). 

where ni →= 1  and n is the total number of fixed head nodes. 

Leakage nodes allow the discharge or the recharge of water to the aquifer system based on 
the difference between its elevation and the groundwater head multiplied by a vertical 
conductance term.   This conductance term is conceptualised as being equivalent to the 
vertical hydraulic conductivity (m day-1) of the material separating the aquifer from the 
leakage node divided by its thickness (m).   

• To include leakage nodes:  

o Use the buttons “Add a leakage node” or “Remove a leakage node” to add or 
remove leakage nodes.  The number of the leakage nodes is adjusted 
automatically in Cell H5.   

o Set the location of the leakage nodes in the cells located in Columns H, I, J and 
K.  The layer number must be set to 1 as only one layer model can be created.  
The elevation (Z) of the node is required to calculate the flow discharging from 
or leaking into the aquifer. 

o Two values of the vertical conductance term must be defined; one when the 
leakage node is effluent and one when it is influent.  These values are defined in 
the cells of Columns L and M respectively.  The following is an explanation of 
the cells used to set the leakage node parameters: 

� Cell H(6+i): A value of 1 should be entered in this cell.  This is the layer 
number where the node is located.  Since only one layer is allowed in the 
model, this cell should only hold a value of 1. 

� Cell I(6+i): Enter the x co-ordinate of the ith leakage node (m). 

� Cell J(6+i): Enter the y co-ordinate of the ith leakage node (m). 

� Cell K(6+i): Enter the z value of the ith leakage node (m).  

� Cell L(6+i): Enter value of the vertical conductance term of the ith leakage 
node when the flow is discharging from the aquifer (day-1). 

� Cell M(6+i): Enter value of the vertical conductance term of the ith leakage 
node when there is leakage into the aquifer (day-1). 

where ni →= 1  and n is the total number of leakage nodes. 
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Figure 15 The “Fixed Heads & Leakage” worksheet 

3.10 BOUNDARY CONDITION WORKSHEET 

This worksheet is used to specify the boundary condition at the nodes located at the edge of 
the model.  A fixed head value or a fixed inflow rate can be specified at these nodes.  To 
define an impermeable boundary at a node a specified flow of zero is specified.  The length 
of this worksheet depends on the size of the model and the shape of its boundary (Figure 16).  
The worksheet must, therefore, be formatted first.  Proceed as follows: 

• Press the button “Get boundary conditions”.  The worksheet will be formatted 
automatically based on the original file produced by ZETUP.  

• For each node set the flag in the cell of Column C to ‘f’ for fixed head and ‘s’ for 
specified flow. 

• For each node set the value of the inflow in m3day-1 in the cell of Column D if a 
specified flow is selected or the value of the fixed head in metres if a fixed head is 
selected.  An outflow at the boundary can be specified by using a negative flow rate. 

Hint: To edit more than one cell at once: 1) select the required cells by holding the “Shift” 
key down and click on the first and the last cells if the cells are contiguous or by holding the 
“Ctrl” key down and click on the required cells if they are not contiguous, 2) enter the 
required value in the formula bar, 3) press “Ctrl+Enter”. 
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Figure 16 The “Boundary Condition” worksheet 

3.11 MONITORING POINTS WORKSHEET 
This worksheet is used to specify the nodes where the variation of groundwater head over 
time is monitored.  In addition, the baseflow in the river can be monitored by defining one or 
more gauging stations along the river.  Lastly, and most importantly, sections of the rivers 
can be defined for which the impact of an abstraction well is calculated over time.  This 
impact is referred to as a “depletion rate” (Figure 17). 

• To specify the nodes where the groundwater head variations with time are monitored (i.e. 
observation well nodes):  

o Use the buttons “Add an observation well” or “Remove an observation well” to 
add or remove observation wells.  The number of the observation wells is 
adjusted automatically in Cell B5.   

o Set the monitoring start and end times in Cells B7 and C7 respectively.  These 
are specified as years.  For example, if only one year is simulated, e.g. 1970, set 
both cells to 1970. 

o Set the location of the observation wells: 

� Cell B(8+i): Enter the x co-ordinate of the ith observation well (m). 

� Cell C(8+i): Enter the y co-ordinate of the ith observation well (m).  

where ni →= 1  and n is the total number of observation wells. 

The model text output file “obswells.out” contains the variation of head over time at each of 
the nodes specified.  This file is described in Section A3.1, Appendix A. 

• To specify the location of the river baseflow gauging stations:  

o Use the buttons “Add a river gauging station” or “Remove a river gauging 
station” to add or remove river gauging stations.  The number of the river 
gauging stations is adjusted automatically in Cell H5.   
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o Set the monitoring start and end times in Cells H7 and I7 respectively. 

o For each gauging station: 

� Cell H(8+i): Enter the river number where the ith gauging station is located.  
(Refer to Section 4.2 for details of river node numbering). 

� Cell I(8+i): Enter the node number which represents the ith gauging station.  
(Refer to Section 4.2 for details of river node numbering). 

where ni →= 1  and n is the total number of gauging stations. 

The model text output file “gauging_stations.out” contains the variation of river flow over 
time at each of the specified gauging station nodes.  This file is described in Section A3.4, 
Appendix A. 

• To specify the river reaches where depletion rates are calculated:  

o Use the buttons “Add a river reach to monitor” or “Remove a river reach to 
monitor” to add or remove river reaches.  The number of the river reaches is 
adjusted automatically in Cell M5.   

o For each river reach: 

� Cell M(6+i): Enter the river number to which the ith river reach belongs. 

� Cell N(6+i): Enter the number of the upstream node of the ith river reach.  
This will be higher than the number of the node at the downstream end of 
the reach.  (Refer to Section 4.2 for details of river node numbering). 

� Cell O(6+i): Enter the number of the downstream node of the ith river reach.  
This will be lower than the number of the node at the upstream end of the 
reach.  (Refer to Section 4.2 for details of river node numbering). 

where ni →= 1  and n is the total number of river reaches. 

The output file showing the river baseflow accretion profiles is described in Section A3.5 in 
Appendix A. 

 
Figure 17 The “Monitoring Points” worksheet 
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3.12 ABSTRACTION WORKSHEET 
This worksheet is used to specify the location of the abstraction wells and their pumping 
rates.  The number of simulation years and the start date of the simulation are read 
automatically from the “Clock & SOR” worksheet.  The first step is to format the worksheet 
(Figure 18) based on the time parameters which are read in “Clock & SOR” worksheet.  
Proceed as follows: 

• Press the button “Format sheet” to format the sheet. 

• Change the number of abstraction wells by pressing the “Add abstraction well” button to 
add an abstraction well or by pressing the “Remove abstraction well” to remove an 
abstraction well. 

• The number of abstraction wells will change automatically in Cell F2. 

• Enter the following information for each abstraction well: 

o Cell A(13+i): This cell gives the number of the ith pumping well.  This cell 
cannot be edited. 

o Cell B(13+i): Enter the x co-ordinate of the ith abstraction well (m). 

o Cell C(13+i): Enter the y co-ordinate of the ith abstraction well (m). 

o Enter the monthly pumping rate (m3day-1) in Column G onwards.  Column G 
relates to the well specified in Cell A14, Column H relates to the well specified 
in Cell A15 and so on. 

where ni →= 1  and n is the total number of abstraction wells. 
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Figure 18 The “Abstraction” worksheet 

3.13 INITIAL RIVER FLOWS WORKSHEET 
The initial baseflow (not total flow) at each of the river nodes is set in this worksheet.  This 
requires a file created by ZETUP to be imported into the Excel worksheet first.  This is 
achieved by pressing the “Import data from ZETUP” button.  The number of rivers is 
adjusted automatically in Cell A10 and information is copied into the cells of Columns A, B, 
C and D starting from Row 12.  The information is composed of blocks of data that are 
separated by dashed lines (an example of this line is shown in Row 11 of Figure 19).  Each 
block corresponds to one river, the number of which is given in the first cell in Column A 
after the dashed line (Cell A12 for example).  The first cell in Column B after the dashed line 
gives the number of nodes in the river.  The initial flow at each node of the rivers can then be 
entered in the corresponding cell of Column D (Figure 19). 

 



OR/08/009 

25 

 
Figure 19 The “Initial River Flows” worksheet 

3.14 TIME VARIANT RIVER FLOWS WORKSHEET 

This worksheet allows the user to specify time variant discharges to a river.  The flow can be 
specified at one or at several nodes of a river.  For each node defined, the variation of flow 
with time must be specified during the simulation period.  The worksheet must first be 
formatted based on the length of the simulation (Figure 20).  Proceed as follows:   

• Press the button “Format sheet” to format the sheet. 

• Press “Add specified flow node” button or the “Remove specified flow node” button to 
add or remove specified flow nodes. 

• New cells in Columns A, B and C are highlighted or made blank.  In addition, cells in 
columns starting from Column G will be highlighted or made blank.  Edit the cells as 
follows: 

o Cell A(13+i): This cell gives the number of the ith  node.  This cell cannot be 
edited. 

o Cell B(13+i): Enter the river number to which the required node belongs. 

o Cell C(13+i): Enter node number that represents the specified flow node in this 
river. 

o Enter data in the yellow cells in the columns after Column F.  Enter the monthly 
specified flow (m3day-1) in the appropriate columns.  Column G relates to the 
node specified in Cell A14, Column H relates to the node specified in Cell A15 
and so on.   
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Figure 20 The “Time Variant River Flows” worksheet 

3.15 RUN ZOOM WORKSHEET 
This worksheet is used to run (i) the application MODIFY_MODEL_RIVERS to change 
river characteristics and (ii) the flow model ZOOMQ3D to simulate the aquifer system 
constructed using the other worksheets.  The Excel worksheet is also used to import the 
model results and to calculate the depletion rates (Figure 21).   

• To modify the river characteristics, press the button “Modify model river parameters”.  
Refer to Section 5 for details on how to use this application. 

• To run ZOOMQ3D press the “Run ZOOM” button.  A DOS box will be launched and 
ZOOMQ3D will produce a solution.  The time required to produce the solution depends 
on the length of the simulation period, the size of the model, the convergence criterion 
and the speed of the user’s computer. 

• To calculate the depletion rates the user must proceed as follows: 

o Run the model without the inclusion of the pumping well for which the impact is 
to be quantified. 

o Press the button “Import results with no abstraction”.  The results will be copied 
to the “No Pumping Results” worksheet automatically. 

o Run the model including the abstraction well under investigation. 

o Press the button “Import results with abstraction”.  The results will be copied to 
the “Pumping Results” worksheet automatically. 

o Press the button “Calculate depletion rates” and the “Depletion Rates” worksheet 
will be updated automatically. 
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o In the “Depletion Rates” worksheet, select Column E and those to the right of it.  
Create an x-y scatter plot of the depletion rates (Figure 22).  For each river reach 
defined in the “Monitoring Points” worksheet one column of data will have been 
written to the right of Column E in the “Depletion Rates” worksheet.  Note that a 
message will pop up preventing the addition of the graph to the active worksheet.  
Proceeding by pressing OK will allow the insertion of the graph as a new 
worksheet. 

 
Figure 21 The “Run ZOOM” worksheet 
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Figure 22 Selection of XY (Scatter) plot used to plot depletion rates 

 
Figure 23 Example plot of depletion rates along two reaches 
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4 Using ArcView to add complex rivers 
4.1 BACKGROUND 
After the user has entered data into the “Rivers” worksheet (Figure 24) the button 
“Run ZETUP” must be pressed.  This runs the program, which constructs the model mesh 
and the model rivers.  On pressing this button the user is presented with a Console 
Application Window (DOS Box) similar to that shown in Figure 24.  The user must answer 
‘y’ (yes) or ‘n’ (no) to the question “Add a river? (y or n)”.  If the user answers ‘y’, the name 
of the file containing the point information for one of the rivers in the model must be entered.  
These text files are referred to as “spline” files.  When straight line rivers are created using 
the Excel worksheet as shown in Figure 24, these files are created automatically and given 
the name “River##_SplinePts.dat” where ## represents the two digit ID number of the river 
(01 to 99).  If the user needs to create more complicated, for example dendritic, rivers these 
text files must be created manually.  To simplify this process a routine has been developed 
using ArcView and a bespoke Windows application that assists the user in performing this 
task. 

 
Figure 24 The “Rivers” worksheet 
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Figure 25 Entry of river spline file name to ZETUP during execution 

A technique is implemented in ZETUP and ZOOMQ3D that differentiates between model 
rivers and the structures (objects) that describe their real geometry and characteristics.  
Information is defined in ZETUP to represent the real structure of rivers.  This data is read 
into the program using the text spline files, which the user must create for non-straight line 
rivers.  The objects describing the shape and connectivity of the river channels are termed 
‘maps’ of the basin.  When the mesh is created, the river maps examine the grid structure and 
use it to construct the numerical model’s rivers on the finite difference grid.  This process is 
described briefly in this section.  First the representation of rivers as ‘maps’ is described. 

4.1.1 Approximating reality: rivers and splines 

This sub-section illustrates how rivers are represented in ZETUP, how they are translated into 
the form required by ZOOMQ3D.  Rivers are represented within ZETUP by structures that 
aim to represent their real geometry closely.  Three types of structures (or objects) are defined 
to represent real rivers.  These are termed catchment maps, river maps and river branches.  
Catchment maps store and manage a number of river maps, which are composed of one or 
more river branches.  The hierarchy is shown in Figure 26.  The objects are described as 
follows: 

Catchment map:  A catchment map is a collection of river maps. 

River map: A river map is composed of a series of polylines (or splines) that describe the 
geometry of the channels within a dendritic river basin i.e. the main river channel and all 
its tributaries.  In addition to describing the geometry of the basin, river maps store data 
relating to the physical and hydraulic characteristics of the channels at specific points 
along their length.  A river map cannot represent two separate river basins i.e. all the 
channels within a river map must be connected.  River maps are referenced using a 
unique integer number. 
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River branch:  Either the main channel of a river basin or one of its tributaries.  A 
numbering scheme must be adopted in which the upstream branches have a higher value.  
The main channel is assigned number 1.  A river branch is one of the polylines forming 
the river map. 

River parameter information is specified at user-defined points along each river branch.  This 
data has to be entered into the text spline files that the program ZETUP reads.  ZETUP reads 
this point information and creates the numerical representation of the rivers on the finite 
difference mesh.  For example Figure 27a shows a dendritic river system, each branch of 
which is defined by a series of points.  ZETUP draws a smooth curve, or spline, through the 
points and then uses this curve to create the model rivers, which for this case are shown in 
Figure 27b.  Reiterating, it is these text files containing the point information along the 
rivers that the user has to create.  The Excel spreadsheet, “ZOOM_IGARF.xls” 
performs this task for the user for straight-line rivers, however, for more complex 
rivers ArcView and the utility CREATE_RIVER_SPLINES must be used. 

 

River Map

River Branches

Catchment Map

River Map

River Branches

 
Figure 26 Representation of real rivers as catchment map, river map and river branch objects 
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Figure 27 (a) Definition of spline points along a river and branch numbers and (b) model rivers 
after construction on finite difference mesh 

Each river branch is defined by its associated spline points and the data at these locations.  In 
Figure 27a there are five river branches, numbered as shown.  Branch 1 is the main river 
channel.  A numbering scheme must be adopted in which the upstream branches have a 
higher value.  Similarly, for each branch, spline points are numbered from downstream 
to upstream.  Spline points must be defined at the ends of the branches and at the 
confluence of two or more channels.  A spline point at a confluence exists on all the 
tributaries flowing to this point (and has to be defined on each branch within the river 
map input file). 

4.2 TRANSLATING ZETUP’S RIVER MAPS INTO ZOOMQ3D RIVERS 

After the river maps have been created and the real rivers approximated by splines, the maps 
are used to generate the rivers required by the simulation model, ZOOMQ3D. 

ZOOMQ3D can simulate the baseflow within dendritic river basins.  Both the baseflow along 
the river and the interaction between the river and the aquifer are modelled.  The structure of 
the numerical model rivers within ZOOMQ3D is described using three terms: rivers, 
branches and river nodes, which have the following definition: 

Rivers: a river is composed of both an interconnected series of river branches and a 
interconnected series of river nodes.  A river cannot be composed of two sets of 
interconnected river nodes that are not themselves connected, i.e. a river cannot 
represent multiple separate catchments.  ZOOMQ3D rivers represent the translation 
of a ZETUP river map onto the finite difference grid. 

Branch: a branch represents the main channel in a catchment or a tributary within the 
river (catchment).  Only dendritic river catchments can be modelled and consequently, 
each branch has one node at its upstream end and one node at its downstream end. 

River node: a river node represents a point on the river that coincides with a horizontal 
point of the finite difference mesh.  The characteristics of the river are defined at each 
river node.  A river node can have up to five upstream connections to river nodes but 
only one downstream connection. 

Branches and river nodes are organised in a specific order described by a numbering scheme.  
For river branches a numbering scheme is implemented in which the upstream 
branches have a higher integer value (Figure 28a).  This numbering scheme is defined by 
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the river map file containing the spline point data.  River node numbers also increase 
upstream and from low branch numbers to high branch numbers (Figure 28b).  The 
river node at the bottom of the catchment is number 1. 

As stated above, model rivers are represented by a series of linked river nodes, which are also 
connected with upper most active aquifer node as illustrated in Figure 29.  Each river node is 
located at the centre of the reach that it represents.  The limits of a reach are the mid-points 
between the central river node and its adjacent river nodes.  River nodes are characterised by 
the following set of parameters: 

• Location specified by x and y co-ordinates. 

• Channel width (m).  This is set to 1 when “ZOOM_IGARF.xls” and its associated 
utilities are used. 

• Reach length (m).  Equivalent to the half the straight-line distance between the 
adjacent two river nodes. 

• River stage (m). 

• River-bed elevation (m).  This is set equal to the river stage when using 
“ZOOM_IGARF.xls” and it associated utilities. 

• River-bed thickness (m).  This is set equal to 1 m when using “ZOOM_IGARF.xls” 
and it associated utilities. 

• Vertical hydraulic permeability (m day-1).  Different values for hydraulic conductivity 
can be specified for influent and effluent river conditions in ZOOMQ3D, however, 
these are set equal when “ZOOM_IGARF.xls” and its associated utilities are used. 
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 (a) (b) 
Figure 28 Numbering schemes in ZOOMQ3D for (a) river branches and (b) river nodes for an example model river 
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Figure 29 Schematic representation of connections between river nodes and grid nodes 

4.3 USING ARCVIEW AND THE CREATE_RIVER_SPLINES APPLICATION 
A Window application “CREATE_RIVER_SPLINES” is used in conjunction with ArcView 
to create the text files containing the river information required by ZETUP.  The Windows 
application is used to number the rivers and branches, to link the nodes along each branch, to 
link the branches of each river and to produce the text files required by ZETUP.  These files 
are then processed by ZETUP to translate the rivers onto the finite difference mesh. 

4.3.1 Using ArcView to generate river data 
There are four steps required to produce the spline files. 

• Use ArcView to create polylines representing the shapes of the rivers. 

• Use the ArcView extension “poly2pts” to convert the polylines to a series of points. 

• Use the CREATE_RIVER_SPLINES Windows application to number and connect the 
points along the branches of the rivers. 

• Export the spline files. 

4.3.1.1 USING ARCVIEW TO CREATE RIVERS 

Set up a simple project that includes: 

• A polyline shape file of the rivers 

• A shape file of the model boundary 

• A DTM (gridded theme) 

Ensure that the following extensions are installed: 

• Cad Reader 

• Geoprocessing 

• Graticules and measured grids 

• Grid analyst  

Upper most active finite
difference node 

Interconnected
river nodes 

River-aquifer 
interaction 

Baseflow 

Baseflow 

Baseflow 
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• Spatial analyst 

• poly2pts.  This is not a standard extension.  If it has not been provided it can be 
downloaded from the ESRI web site.  It converts polylines into series of points. 

Start a new ArcView project: 

• Add the river, boundary and DTM themes to your project using View->Add Theme. 

• If the DTM information is available as ASCII data, import it into the project as follows: 

o File->Import data source 

o Select ASCII Raster  

o Select data file 

• Use the Clip feature in the Geoprocessing Wizard in ArcView to produce a shape file in 
which all river polylines fall within the model boundary. 

o From View->GeoProcessing Wizard select “Clip one theme based on another” 

o Press “Next” and select the river shape file as the input theme and the model 
boundary as the polygon overlay theme 

• Select the new tidied up river theme. 

• Select “Theme-> Convert to points” to create a new shapefile containing only points along 
the rivers (N.B. the poly2pts extension must have been added). 

o Select an interval for the laying out points e.g. 250 m. 

o Select a file name for the new shape file 

• The newly created point theme can be edited and tidied where it appears too complicated, 
however, this can also be performed at a later stage.   

• Next extract the elevation of these points from the DTM.  Select the new point theme and 
choose “Grid Analyst->Extract X, Y and Z values for Point theme from Grid theme”. 

• Open the table associated with the river point theme and export the data  
“File->Export data source”.  Modify the exported data file using Excel and a text editor to 
produce a space separated file containing the three columns X, Y and Z for each point in 
the river point theme.  Z is the elevation of the DTM at the x, y point. 

• Save the new file as a “tab delimited” text file and call it “GISRivers.dat” 

4.3.2 Using the Windows application to create the river input files for ZETUP 
The CREATE_RIVER_SPLINES Windows application is composed of three main parts: the 
display window, a menu bar and a toolbar (Figure 30). The display window is used to number 
and connect the river points.  The menu bar allows the selection of the functions used to 
manipulate the points in the display window.  The tool bar provides the user with some 
specific functions that can be selected quickly. 

When the Windows application is launched from the Excel worksheet, the text file 
“GISRivers.dat” is read and the points produced by ArcView displayed as illustrated in 
Figure 30.  The menu bar is used to define the rivers and branches, to link the nodes and to 
connect the branches.  Three steps are required to complete any of these operations.  These 
are: “Select number”, “Start associating nodes”, “Stop associating nodes” (Figure 30). The 
Windows application can be used to zoom to a window, zoom to all, to draw individual or all 
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the rivers, and to delete river nodes or their connections.  These functions can also be 
accessed from the toolbar. 

 
Figure 30 Display of the spline points before numbering and linking 

To define a ID number of a river select “Define Rivers” from the menu then: 

• Select “Select river number” and enter the river number. 

• Select “Start associating nodes”. Draw (click and drag) a box around the nodes to be 
included in the river. 

• Select “Stop associating nodes” when finished. 

• Repeat for each river (connected set of points). 

• You can check that all the nodes have been assigned to a river by selecting “Check 
river definition”. 

The perimeter of the circles representing the river nodes change colour according to the river 
number they belong to.  The circle is filled with a colour that indicates the branch number the 
river node belongs to (Figure 31).  To define the branch numbers of a river select “Define 
Branches” from the menu then: 

• Select “Select river number”.  Enter the river number.  Only the selected river is 
displayed. 

• Select “Select branch number”.  Enter the branch number. 

• Select “Start associating nodes”. Draw (click and drag) a window around the nodes to 
be included in the selected branch. 

• Repeat for each river branch in the selected river 
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• Select “Stop associating nodes” when finished. 

You can check that all the nodes have been assigned a branch number by selecting “Check 
branch definition”. 

To link the nodes of a river branch select “Link Nodes” from the menu then: 

• Select “Select river and branch”.  Enter the river number and the branch number.  Only 
the selected branch is displayed. 

• Select “Start linking nodes”. 

• A popup dialog box will appear asking the user to double click on the downstream node of 
the branch. 

• Start linking the nodes by drawing a box (click and drag) around the nodes to be linked: 

o  The box should include the downstream node or one node that is linked to its 
downstream node. 

o The window cannot include more than one node that has already been linked. 

• Select “Stop linking nodes” when finished. 

It is possible to unlink all the nodes in a branch by selecting “Clear node links of branch” 
under the “Link Nodes” menu option.  Separate links can be deleted by pressing the button 

 on the toolbar or by selecting “Delete connection” from “Delete” and then double 
clicking on the node whose downstream link is to be deleted. 

It is also possible to delete nodes if required.  This can be done by pressing the button  
on the toolbar or by selecting “Delete node” from “Delete” and then double clicking on the 
node to be deleted. 

After completing the river and branch definition and linking process, the spline files can be 
produced.  Select “Write spline file” from the “File” menu option.  This will create a separate 
spline file for each river defined in the Windows application named “River##_SplinePts.dat” 
where ## represents the river ID number. 

The toolbar allows the following operations: 

 Save work as you progress. 

 Save work and exit the Windows application. 

  Exit the Windows application without saving. 

 Zoom all.  The display is enlarged to include all the rivers though not all the 
rivers are necessarily plotted.  

 Zoom to a selected window. 

 Delete a node.  Press this button then double click the node to delete. 

 Delete a connection.  Press this button and double click the node whose 
downstream link is to be deleted. 
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 Draw all rivers.  All the rivers within the current display are plotted. 

 Gives the river and branch number at a node 

 

 
Figure 31 Display of one river after numbering the rivers and numbering and linking the 
branches 
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5 Modifying model river parameters 
The river spline text files, produced using the “CREATE_RIVER_SPLINES” Windows 
application, are processed by “ZETUP” to produce the model rivers that are linked to the 
finite difference mesh.  ZETUP produces the file text file “rivers.dat”, which contains all the 
model river information.  The hydraulic parameters of the model river nodes are set to the 
default values listed in Table 2.  For simplicity only the river bed hydraulic conductivity and 
river stage can be modified without manually editing the text file.  The bed permeability and 
river stage at each river node can be modified using the Windows application 
MODIFY_MODEL_RIVERS, which is run from the worksheet “Run ZOOM” in the Excel 
tool “ZOOM_IGARF.xls”.  This program modifies the ZOOMQ3D input file “rivers.dat”. 
Table 2 Model river node parameters 

River node parameter Value 
Channel width (m) Set to 1 m 

Reach length (m) Determined by the mesh spacing 

River stage(m) Set by the user 

River bed elevation (m) Set equal to the river stage 

River bed thickness (m) Set to 1 m 

River bed hydraulic conductivity (m day-1) Set by the user. 
 

This application has a display window and a menu bar with one function only.  This is to save 
the work and to exit.  When the application is launched, the data file “rivers.dat” produced by 
“ZETUP” is read and the river networks are drawn in the display window (Figure 32).  The 
values of the parameters at the nodes can then be modified.  To adjust the parameter values at 
one node double click on it.  A dialog box will then popup showing the co-ordinates of the 
node and the values of the river stage and the bed conductivity (Figure 33a).  The river stage 
and bed conductivity can then be edited in this dialog box. 

To adjust the parameter values of a set of nodes the user must draw (click and drag) a box 
around the relevant nodes.  A dialog box will popup and show the number of nodes selected 
and values of zero for the bed conductance and the river stage (Figure 33b).  Care should be 
taken at this stage because pressing “OK” will set the parameter values to zero at the selected 
nodes.  If the selection is not correct “Cancel” should be used.  Enter the new parameter 
values in the dialog box and press “OK”. 
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Figure 32 Display of the river network produced by “ZETUP” 

 

 (a)  (b) 

Figure 33 Dialog box for changing the characteristics of (a) one node and (b) multiple nodes 
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Appendix A Summary of ZOOM text output files 

A1 THE PHILOSOPHY OF MODEL OUTPUT 
The philosophy behind the structure of ZOOMQ3D model output is to separate different types 
of data between files.  That is, each file contains one specific type of information only.  This 
simplifies the post-processing of model output and means that standard software packages can 
be used to interpret and visualise results.  All the output files are ASCII text files with a very 
simple format.  They are easily examined using a text editor or processed using spreadsheet 
software. 

The list of output files produced by ZOOMQ3D is presented in Table 3, though not all of 
these are always produced.  For example, if no rivers are included the model, three fewer files 
are created.  Each of the ZOOMQ3D output files is described in the following section. 
Table 3 List of all ZOOMQ3D output files 

Model feature Relevant file names 
Groundwater heads 

1. Over time 
2. For restarting model 
3. For contouring 

 
obswells.out 
finalh.out 
contour.txt 

Rivers gauging_stations.out, accretion.out*, riverflow.out* 
Water balances 

1. Global water balances 
2. Nodal flow balances 

 
global.out, global_tv.out 
flowbal.out* 

De-watering and re-wetting dewatering.out 
Progress of solution zoomq3d.out, transcycle.out 

N.B.  Files appended with an asterisk (*) are tab delimited 

A2 PROCESSING MODEL OUTPUT 
Model output is readily processed and visualised using spreadsheet software, Surfer (Golden 
Software Inc., 1994) and a text editor.  Because each model file contains only one type of 
data, the user is not required to extract information from many different locations within a 
single file.  All text files are space delimited except for three that are tab delimited.  These 
three files are identified in Table 3. 

A3 DESCRIPTION OF OUTPUT FILE FORMATS 

The format of each of the files listed in Table 3 is described in detail in the following sub-
sections. 

A3.1 Observation well data 
The nodes at which groundwater head is monitored over time are specified in the input file 
named in the file ‘zoomq3d.dat’, for example ‘obswells.dat’.  The time versus groundwater 
head record at these nodes is output to the file also named in ‘zoomq3d.dat’, for example 
‘obswells.out’.  This output file contains one line of data for each time-step of the simulation 
with the following format 
 day  stress_period  block time_elapsed  h1  h2  h3  h4 … hn 

where 

 day is the end of the day when the flow was recorded, 
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 stress period is the stress period number, 

 block is the time block number of the flow measurement, 

 time_elapsed is the time simulated since the beginning of the model run, 

 h1 is the head (m) in the first observation well defined in ‘obswells.dat’, 

 h2 is the head (m) in the second observation well defined in ‘obswells.dat’, 

 hn is the head (m) in the nth observation well defined in ‘obswell.dat’. 

The output file is space delimited and is easily opened using spreadsheet software, which can 
be used to produce groundwater head hydrographs. 

A3.2 Contouring groundwater heads 
The computed groundwater heads are written to an output file in a format suitable for 
contouring.  The name of the output file is specified in the input file ‘zoomq3d.dat’.  This 
output file, for example ‘contour.txt’ contains groundwater head data for a single time-step 
only and is over-written periodically during the simulation.  The frequency with which the file 
is produced is defined in the input file ‘clock.dat’.  Each time it is written, the previous data 
set is lost.  However, groundwater head data, in this format, can be saved by specifying the 
times of interest in the input file ‘contour_times.dat’. 

The format of this output file is simple and is suitable for contouring using Surfer (Golden 
Software Inc., 1994).  The groundwater head at each horizontal location is written on a 
separate line.  The file has the following format 
  x  y  h1  h2  h3  …  hn 

where 

 x is the x co-ordinate of the grid point, 

 y is the y co-ordinate of the grid point, 

 hi is the groundwater head in the ith layer. 

If a node is dry the groundwater head value is replaced by –999. 

ZETUP produces a Surfer (Golden Software Inc., 1994) blanking file, which can be used to 
blank the data around the boundary of the model when contouring.  This file is called 
‘boundary.bln’. 

A3.3 Groundwater heads in format to re-start a simulation 

Groundwater heads are written to an output file in a format that enables a model run to be re-
started from conditions modelled during the current simulation.  The name of this output file, 
for example ‘finalh.out’, is specified in the input file ‘zoomq3d.dat’.  It contains the 
groundwater head at each node of the model at the end of a single time-step and is over-
written periodically during the simulation.  The frequency with which the file is produced is 
defined in ‘clock.dat’.  Each time it is written, the previous data set is lost. 

In order to use this output file to re-start a simulation it is necessary to rename it ‘initialh.dat’ 
and change the character flag on the following line in the input file ‘clock.dat’ to a ‘t’ for true: 

Rerunning t(true) of f(false) 
t 
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A3.4 River flow gauging 
The river nodes at which the baseflow is monitored over time are specified in the input file 
named in the file ‘zoomq3d.dat’, for example ‘gauging_stations.dat’.  The time-discharge 
record at these nodes is output to the file also named in ‘zoomq3d.dat’, for example 
‘gauging_stations.out’.  This output file contains one line of data for each time-step of the 
simulation with the following format 
 day  month  year time_elapsed  Q1  Q2  Q3  Q4 … Qn 

where 

 day is the end of the day when the flow was recorded, 

 month is the month number, 

 year is the year number of the flow measurement, 

 time_elapsed is the time simulated since the beginning of the model run, 

 Q1 is the flow (m3 day-1) in the first river node defined in ‘gauging_stations.dat’, 

 Q2 is the flow (m3 day-1) in the second river node defined in ‘gauging_stations.dat’, 

 Qn is the flow (m3 day-1) in the nth river node defined in ‘gauging_stations.dat’. 

The river nodes are listed in the same order as they are defined in the input file.  The output 
file is space delimited and is easily opened using spreadsheet software, which can be used to 
produce river baseflow hydrographs. 

A3.5 River baseflow accretion profiles 
River baseflow (not total flow) accretion data is written to the output file named in 
‘zoomq3d.dat’, for example ‘accretion.out’.  The data is in a form suitable for the rapid 
production of accretion profiles using spreadsheet software.  This output file contains flow 
data for a single time-step only and is over-written periodically during the simulation.  The 
frequency with which the file is produced is defined in the input file ‘clock.dat’.  Each time it 
is written, the previous data set is lost.  Accretion profiles at different times can be saved by 
specifying each node along the river section of interest as a gauging station in the relevant 
input file. 

The output file is tab delimited and has a simple format.  An example output file is shown in 
Figure 34.  The number of rivers in the model is written on the first line.  A block of data then 
follows for each river.  Eleven columns of data are defined within each block, which are 
separated by comment lines composed of a series of dashes.  Each row represents one node of 
the river.  The eleven columns contain the following data: 

1. River branch number. 

2. River node number. 

3. x co-ordinate of river node (m). 

4. y co-ordinate of river node (m). 

5. Distance downstream from uppermost node in branch (m). 

6. Baseflow (m3day-1). 

7. Groundwater head (m). 

8. River stage (m). 
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9. River bed elevation (m). 

10. River bed vertical hydraulic conductivity under effluent conditions (m day-1). 

11. River bed vertical hydraulic conductivity under influent conditions (m day-1). 

A3.6 River baseflows in a format to re-start a simulation  

River baseflows are written to an output file in a format that enables a model run to be re-
started from conditions modelled during the current simulation.  The name of this output file, 
for example ‘riverflow.out’, is specified in the input file ‘zoomq3d.dat’.  It contains the river 
baseflow at each node each river in the model at the end of a single time-step and is over-
written periodically during the simulation.  The frequency with which the file is produced is 
defined in ‘clock.dat’.  Each time it is written, the previous data set is lost. 

The file has exactly the same format as the input file ‘riverflow.dat’, which is used to define 
initial river baseflow conditions.  Consequently, in order to use this output file to re-start a 
simulation it is only necessary to rename it ‘riverflow.dat’. 
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2 

---------------------- 

River 1 

Branch Node X Y Dist.downstream Flow Head Stage Bed Elevation Kz Effluent Kz Influent 

1 9 294500 572500 0 5765.87 7.80 7.5 6.5 1 1 

1 8 295000 572500 500 5931.98 7.53 7.5 6.5 1 1 

1 7 295500 572500 1000 7050.44 7.68 7.5 6.5 1 1 

1 6 296000 572000 1707.11 7362.65 7.54 7.49 6.49 1 1 

1 5 296000 571500 2207.11 8172.72 7.35 7.21 6.21 1 1 

 etc for each node in each branch of river 1 

---------------------- 

River 2 

Branch Node X Y Dist.downstream Flow Head Stage Bed Elevation Kz Effluent Kz Influent 

1 14 292500 575500 0 12500 32.69 68 67 1 1 

1 13 293000 575500 500 17239.4 16.42 16.03 15.03 1 1 

1 12 293500 576000 1207.11 21484.3 8.85 8.55 7.55 1 1 

1 11 294000 576500 1914.21 31937.7 7.09 7 6 1 1 

1 10 294000 576000 2414.21 32773.8 8.08 8 7 1 1 

1 9 294500 576000 2914.21 36011.6 6.36 6.09 5.09 1 1 

 etc for each node in branch 1 of river 1 

2 20 292000 578000 0 2000 22.12 37 36 1 1 

2 19 292500 578000 500 0 21.7 36 35 1 1 

2 18 293000 578000 1000 0 17.13 33.53 32.53 1 1 

 etc for each node in branch 2 of river 1 

Figure 34 Example output file containing river baseflow accretion data 
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A3.7 De-watering and re-wetting 
At the end of each time-step information is written to the file ‘dewatering.out’ informing the 
user of which nodes have de-watered and which have re-wetted.  The layer number and co-
ordinate of each of these nodes is written to the file. 

A3.8 Nodal flow balances 
Nodal flow balance information for every node in the model is written to the file, 
‘flowbal.out’, for example, named in the input file ‘zoomq3d.dat’.  This output file contains 
flow balance data for a single time-step only and is over-written periodically during the 
simulation.  The frequency with which the file is produced is defined in the input file 
‘clock.dat’.  It is always re-written at the end of the simulation.  The first line of the file is a 
text string that specifies the time at which information is output.  The second line contains the 
headings for the following columns of data.  Each subsequent line represents one node in the 
model.  A description of each column is given in Table 4.   
Table 4 Data contained in nodal flow balance output file 

Column 
of file 

Description of data 
(Rates of flow are for the last time-step only) 

1 Layer of the node 
2 x co-ordinate of the node 
3 y co-ordinate of the node 
4 Area of the node (m2) 
5 Flow imbalance at the node (m3 day-1) 
6 Inflow to the node in the x-direction from the left (m3 day-1) 
7 Outflow from the node in the x-direction to the right (m3 day-1) 
8 Inflow to the node in the y-direction from below (m3 day-1) 
9 Outflow from the node in the y-direction to above (m3 day-1) 
10 Inflow to the node in the z-direction through the base (m3 day-1) 
11 Outflow from the node in the z-direction through the top (m3 day-1) 
12 Specified inflow at the boundary (if a boundary node) (m3 day-1) 
13 Rate of change of storage at node (m3 day-1).  Positive values are increases in storage. 
14 Recharge applied at the node (m3 day-1) 
15 Rate of leakage between the aquifer and the river (m3 day-1) 

Positive values represent influent river nodes 
16 Rate of leakage to a leakage node (m3 day-1) 

Positive values represent an outflow from the aquifer 
17 Rate of abstraction at the node (m3 day-1) 

Abstraction is represented by negative values 
18 Spring flow (m3 day-1) 

Positive values represent flow of the aquifer (negative values not possible) 



OR/08/009 

49 

A3.8 Global flow balances 
Global flow balance information for the model is written to the file ‘global.out’.  This output 
file contains flow balance data for a single time-step only and is over-written periodically 
during the simulation.  The frequency with which the file is produced is defined in the input 
file ‘clock.dat’.  It is always re-written at the end of the simulation.  This file gives a water 
balance for the whole model over a time-step.  An example file is shown in Figure 35.  
Information includes the total recharge to the model, the total flow across its boundary, the 
total abstraction, the total downstream flow and anthropogenic input to each river, the total 
outflow to leakage nodes and fixed heads, the total change in storage over the last time-step 
and the total spring flow.  These flow rates are summed to give a global flow imbalance 
figure, which is written on the last line of the file. 

 

GLOBAL FLOW BALANCE AT END OF 4/12/1974 (TS/SP/BLOCK) 
--------------------------------- 
Total recharge: 192554 m3/d 
Total boundary inflow: 0 m3/d 
Total abstraction: 32900 m3/d 
River 1 
 Downstream flow: 8213.6 m3/d 
 Anthropogenic input: 5000 m3/d 
River 2 
 Downstream flow: 48155.2 m3/d 
 Anthropogenic input: 32000 m3/d 
River 3 
 Downstream flow: 1.31088e+006 m3/d 
 Anthropogenic input: 1.217e+006 m3/d 
River 4 
 Downstream flow: 41388 m3/d 
 Anthropogenic input: 24000 m3/d 
Total leakage out of aquifer: 27884.4 m3/d 
Total outflow to fixed heads: 0 m3/d 
Total increase in aquifer storage: 19.3241 m3/d 
Total spring flow: 1111.31 m3/d 
 
GLOBAL FLOW IMBALANCE: 0.61335 m3/d 

Figure 35 Example global flow balance output file 

A3.9 Time-variant global flow balances 

Global flow balance information for every time-step of a simulation is written to the file, 
‘global_tv.out’.  The file contains the columns of data listed in Table 5.  One line of data is 
written to the file per time-step.  The file is space delimited and is readily opened using 
spreadsheet software for manipulation. 
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Table 5 Data contained in ‘global_tv.out’ 

Column Description of data 
1 Time within stress period (days) 
2 Stress period number 
3 Block number 
4 Time since start of simulation (days) 
5 Total recharge (m3 day-1) 
6 Total inflow at model boundary (m3 day-1) 
7 Total abstraction (m3 day-1) 
8 Total outflow from rivers (m3 day-1) 
9 Total discharge/inflow to rivers (m3 day-1) 
10 Total flow through leakage nodes (m3 day-1).  Positive out of aquifer. 
11 Total outflow to fixed head nodes (m3 day-1) 
12 Total storage increase (m3 day-1).  Positive values are increases in storage 
13 Total spring flow (m3 day-1) 
14 Global flow imbalance (m3 day-1) 

 

 

A3.10 Convergence of solution 
Information describing the progress of the solution during each time-step is written to the 
output file ‘zoomq3d.out’.  At the end of each user defined number of iterations (the last 
number entered in ‘sor.dat’) of the successive over-relaxation solution process the following 
information is output 

• the sum of the absolute values of the flow imbalance (residual) at each model node 
(m3 day-1). 

• the location of the node with the greatest nodal flow imbalance (residual) and the 
value of this flow imbalance (m3 day-1). 

• the location of the node where the greatest change in groundwater head occurred 
during the last iteration. 

When the numerical solver converges to the solution for a time-step the global flow 
imbalance is also written to the output file. 

A3.11 Variation in transmissivity 
Unconfined conditions are simulated by repeating the solution for a time-step in a cyclical 
process.  At the beginning of each cycle, transmissivity is calculated by integrating the 
hydraulic conductivity over the saturated thickness of the finite difference nodes.  The 
cyclical process ceases when either the change in transmissivity between cycles is below a 
user-defined value or after the maximum number of cycles has been performed.  The variation 
in transmissivity (m2 day-1) over a cycle is written to the output file ‘transcycle.out’ to that the 
user can examine the progress of the process.  An example ‘transcycle.out’ file is shown in 
Figure 36. 
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---- Change in transmissivity for each cycle ---- 
Time:4  Month:1  Year:1970 
 Cycle: 1 Max T Change: 1.25901 
 Cycle: 2 Max T Change: 0.502317 
---- Change in transmissivity for each cycle ---- 
Time:10  Month:1  Year:1970 
 Cycle: 1 Max T Change: 2.11305 
 Cycle: 2 Max T Change: 1.04613 
 Cycle: 3 Max T Change: 0.518062 
 etc for each time-step 

Figure 36 Example ‘transcycle.out’ output file 

 

 

 


